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Accessibility Top Ten

Checklist for creating accessible documents

The University of Washington (UW) strives to ensure that everyone has access to the same
services and content, including services and content made available using information
technology (IT). Read UW's IT Accessibility policy. To uphold these standards, the College of
Arts & Sciences has created this checklist based on UW IT's Creating Accessible Documents
resources.

1. Does the document have tagged headings?
e One H1 tag per document.
o Surrounding the main heading.
e H2-H6 tags on subheadings.
0 Reflects structure of document (e.g., H2 for subheadings, H3 for
sub-subheading).
e Visual formatting alone is not enough.
e To fix: Add Tagged Headings

2. Are lists used correctly?
e Use the document's list function.
e Visual formatting alone is not enough:
o Ordered lists are for when order matters.
o Unordered lists are for when order does not matter.
o Description lists are used to group terms with descriptions.
o Multilevel lists have more than one indent like this list.
o Do notuse H tags in lists - produces unpredictable results
e Do not use hard carriage returns between list items, instead use paragraph
spacing to achieve the desired look.
e Tofix: Use Lists Correctly

3. Do all images have alternate text?
e Brief, impactful, to-the-point.
e Avoid using “image of” or “photo of.”
e Use “decorative image” option only if image is purely decorative.
e To fix: Add Alternate Text to Images

4. Are all hyperlinks meaningful?
e Make it easy to predict where the link leads from the displayed text alone.
o Use this “Eind more info on UW-IT’s accessibility page”
o Not this “Find more info here”
e Avoid writing “link” in the descriptive text because it is redundant.
e To fix: Using Meaningful Link Text

5. Does the document avoid reliance on visual cues?
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e Avoid descriptions like “circular red button to the right.”
e Ensure that all links are underlined and don't rely on text color alone to stand

out.
e To fix: Avoid Visual Cues

6. Does the document have a designated language (English, Spanish, etc)?
e Many screen readers support multiple languages.
e To fix: Identify Document Language

7. Are all text-background combinations high contrast?

Check for minimum of 4.5 to 1 contrast ratio.

Good contrast options: white/black, purple/white, dark blue/white.
Bad contrast options: gold/white, red/white, light blue/white.

To fix: Provide Sufficient Color Contrast

8. Are all titles and body text large enough?
e All text should be 10.5 point (14 pixel) or larger.

9. Are all paragraphs left-justified?
e Left aligned text is easier to read than centered text for paragraphs because
the starting place of each line does not change.
e Without a straight left edge, there is no consistent place where users can
move their eyes to when they complete each line.
e More information about Centered Text vs Flush Left.

10. Are there more than 2-3 all capitalized words in a row?
e Using all caps for buttons and headings reduces readability & understanding.
e In email or social media, all caps means that you are yelling.

Document created by Nicole Grabiel, Safiya Bansfield and Wendelin Dunlap on 09/28/2021.
Contact us with questions.
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Accessibility How-To’s

Add Tagged Headings

Tagged headings give a document structure by identifying different sections of the
document. The screen reader uses those tagged headings to create a navigation menu that
allows the user to easily skip between sections. For example, “Accessibility How-To's” is
tagged as Heading 1 so it would appear first on the navigation menu. Then nested within
Accessibility How-To's would be all text tagged as Heading 2 such as “Add Tagged Headings”
and “Use Lists Correctly”. Finally, nested within those Heading 2 tags would be Heading 3
tags like “Word & Outlook”, so that if a screen reader user wanted to find out how to tag
headings in Word, they could navigate directly to that section instead of having to listen to
the entire document first.

Word & Outlook
*If you use either of these methods to create or edit a template, the tags styles will save for
all documents created with the template.

If the heading text is already formatted

1. In the Home tab of the toolbar, select Styles Panes. A new sidebar that lists the
available styles will open.

2. Select the text to which you want to add an H1 tag; it will likely be the title text at the
beginning of your document.

3. Hover your mouse over the Heading 1 button in the sidebar until you see an arrow
appear. Select the arrow and then choose “Update to Match Selection” from the
drop-down menu. If the text is successfully assigned an H1 tag, you will see the
Heading 1 text in the sidebar update to reflect the formatting of your selected text.

4. Repeat steps 2-3 to add H2-H5 tags.

If the heading text is not already formatted

1. In the Home tab of the toolbar, select Styles Panes. A new sidebar that lists the
available styles will open.

2. Hover over the Heading 1 button in the sidebar until an arrow appears and then
chooses “Maodify Style...” from the drop-down menu. A new pop-up menu will appear
in which you may edit the formatting as you see fit. Once the formatting is correct,
select OK on the pop-up menu and you will see the Heading 1 text in the sidebar
update to reflect your formatting choices.

3. Select the text to which you want to add the H1 tag and then click the Heading 1
button in the sidebar. If the H1 tag is successfully added, you will see the text in your
document update to match that of the Heading 1 text in the sidebar.

4. Repeat steps 2-3 to add H2-H5 tags.

PDF
Before proceeding, check to see if the PDF has o preexisting tag structure.
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1. Select the Tags button in the left sidebar. A new sidebar will open that shows all of

the tags.

2. If the sidebar says “No tags available”, the PDF does not have tag structure. If there
are tags, click on each one to see which element of the PDF it corresponds to. A
substantial structure will have a tag corresponding to each element of the PDF, even
if a few elements are mislabeled, while a weak structure will fail to tag each element.
Proceed with the following instructions according to your identified tag structure.

Nonexistent or weak tag structure

1. Select the Order button in the left sidebar. A new sidebar will open.

2. Clear any preexisting tag structure by right clicking on the document name in the
sidebar and then choosing “Clear page structure” from the drop-down menu.

3. Right click again on the document name and then choose “Show reading order
panel” from the drop-down menu. A pop-up menu will open.

4. Use your cursor to draw a box around an element of the document. If properly
selected, the element should be outlined once you release the cursor.

5. In the pop-up menu, choose the tag that corresponds to that element. A shaded box
will appear around the element.

6. Repeat steps 4 and 5 for each element in the document. Once you have tagged each
element, close the reading order panel.

7. Click the Tags button in the left sidebar to see all the tags that you just added. Click
on each tag to check that it corresponds to the correct element of the PDF.

Substantial tag structure

1. Identify which tags are incorrect by clicking on each tag to see which element it
corresponds to, keeping in mind that H2 tags should only follow H3 and so on and
that the root tag should be “Document”.

2. Right-click on any of the incorrect tags and then choose “Properties” from the
drop-down menu. A new pop-up menu will open.

3. Inthe Type field, choose the correct tag from the drop-down menu and then close
the pop-up menu.

4. Repeat steps 2 and 3 for each incorrect tag.

HTML
e Add <h1> for level 1 headings. Typically, only the main title of a document with have
a H1 tag.
e Add <h2> through <h6> tags for level 2 through level 6 headings.

PowerPoint

e PowerPoint does not use heading tags to determine reading order, but rather relies
on its templates to guide screen readers. Consequently, you should always use the
template function when adding slides to a PowerPoint presentation.

e |tis always a good idea to check the reading order, especially if you did not use a
template or added any elements. To check and edit the ready order:
1. In Home tab of the toolbar, select “Arrange” and then “Selection Pane...". A new

sidebar will open on the right.
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2. Click on each entry to see which element on the slide it corresponds to. Drag an
drop the entries to reflect a logical reading order.
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Use Lists Correctly

Word, Outlook & PowerPoint
The key to adding lists correctly to Word, Outlook, and PowerPoint is to use the built-in list
function. Using the list function automatically formats and tags the information as a list. In
all three applications, the list function can be found in the Home tab of the toolbar under
Paragraph.
e For unordered lists, choose the bulleted list icon.
o The drop-down arrow allows you to choose different kinds of bullets and
even create a new bullet style.
e For ordered lists, chose the numbered list icon.
o The drop-down arrow allows you to choose different numbering and
lettering styles.
e For multilevel lists, choose the multilevel list icon.
o The drop-down menu allows you to choose or format several different list
styles.

PDF
Creating a list in Adobe Acrobat Pro
1. Click on the Edit PDF button in the right sidebar. A new sidebar will open.
2. Add a textbox to the document by selecting “Add text” in the upper toolbar and then
clicking anywhere on the document.
3. Inthe Edit PDF menu, click on the bulleted list icon for unordered lists or the
numbered list icon for unordered lists.
4. Add to the content of the list as you see fit.

Making sure pre-existing lists are correctly tagged
Based on how you exported the document to PDF, it is possible that the list was not
correctly tagged as a list when the document converted to PDF.

1. Select the Tags button in the left sidebar. A new sidebar will open that shows all
tags.

2. Click on the tags to see which elements of the document they correspond to. Any
lists should be tagged as <L>. If all lists are tagged with <L>, you do not need to do
anything more. If some or all lists are missing <L> tags, proceed to step 3.

3. Right-click on any of the incorrect tags and then choose “Properties” from the
drop-down menu. A new pop-up menu will open.

4. Inthe Type field, choose the “List” from the drop-down menu and then close the
pop-up menu.

5. Repeat steps 3 and 4 for any other misidentified lists.

HTML
e Use <ul>tag to create an unordered list.
o Add list items with <li> tag.
e Use <ol>tag to create an ordered list.
o Add list items with <li> tag.
e Use <dI> to create a descriptive list
o Define the term with <dt> tag.
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o Describe each term with <dd> tag.

<ul> <o1l>
<li>Dogs</1li> <li>Dogs</li>
<li>Cats</1li> <li>Cats</1li>
<li>Birds</1i> <1i>Birds</1i>
</ul> </ol>
<d 1>
<dt>Dogs</dt>

<dd>human's best friends</dd>

<dt>Cats</dt>

<dd>furry companions</dd>
</dl>
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Add Alternate Text to Images

Word, Outlook & PowerPoint
1. Right click on the image to which you want to add alternate text and the select “Edit
Alt Text..."” in the drop-down menu. A new sidebar menu will open.

2. In the sidebar, enter a brief description of the image that explains its purpose on the
page.

PDF
1. Make sure that all images in your PDF are tagged as “Figures” by opening the tags

menu and looking for “Figures” tags. For more specific instructions, see Add tagged

headings in PDF. If all images are properly tagged, proceed to step 5. If not, continue

to step 2.

Click the Order button in the left sidebar. A new sidebar will open.

3. Right-click any of the links in the Reading Order menu and select “Show reading
order panel”. A new menu will pop up.

4. Use your cursor to draw a box around the image to which you want to add alt text.
The selected area will have highlighted borders. In the pop-up menu, choose
“Figure”. Repeat for all images and then close the pop-up menu.

5. Open the accessibility menu by clicking the Accessibility icon in the right sidebar. A
new menu will open on the right of the page.

6. Select “Set Alternate Text". Adobe will automatically search for all images in the
document that are tagged as Figures and open a new pop-up menu where you can
add alt text.

7. Enter a brief description of each image that explains its purpose on the page and
once finished, choose “Save and close”.

N

HTML
e For meaningful images, add an alt attribute to the <img> element.

<img src="blossoms.png" alt="Cherry trees in bloom on the UN campus">
1

e For purely decorative images, add an empty alt attribute (alt="") and a presentation
role attribute (role="presentation”).

! Image from UW IT's Accessibility Checklist.
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Use Meaningful Link Text

Word, Outlook & PowerPoint
Method 1
1. Paste the URL where you want the hyperlink to be. If the URL does not automatically
become a hyperlink, enter a space immediately after the URL.
2. Right click on the hyperlink, then click Hyperlink and select “Edit Hyperlink...”. A new
pop-up menu will open.
3. Enter your meaningful link text into the “Text to Display” field and then click OK. The
hyperlink should have changed to reflect the meaningful link text.

Method 2
1. Type the meaningful link text into the document where you want it.
2. Highlight the link text and then click the Insert Link button from the Insert tab of the
toolbar. A new pop-up menu will open.
3. Paste the URL into the Address field and then click OK. The text that had been
highlighted should now be a hyperlink.

PDF
1. Open the edit PDF menu by clicking its icon in the right sidebar.
2. Type the meaningful link text into the document where you want it.
3. Highlight the meaningful link text, right click on it, and then choose “Create Link...".
4. In the pop-up menu, choose “Open a webpage” for Link Action and edit the Link

Appearance as you see fit. The following settings are recommended:
e Link Type: Visible Rectangle
e Line Style: Underline
e Highlight Style: Outline
e Thickness: Thin
5. Once you have adjusted the link action and appearance, click next. A new pop-up
menu will open where you can paste the URL. Paste the URL and then click OK.

HTML

When coding the link into the webpage, make sure that, when read independently, the link
text makes clear the purpose of the link. In the following example, the meaningful link text
is “Study Abroad Information for Students”.

<p>For more information about study abroad, see <a

href="https://www.washington.edu/studyabroad/students/">Study Abroad
Information for Students</a>.</p>
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Avoid Visual Cues

Techniques for All Document Types
e Refer to structural rather than spatial location.
o Ex."inthe sidebar” vs. “to the left”
e Refer to object’s function rather than its appearance
o Ex."”Draw a Shape button” vs. “blue square button”
e Add additional signifiers when using color to convey meaning
o Underline hyperlinks

W

o Forrequired fields, include the word “required” in the label or, in HTML, add

the required attribute.
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Identify Document Language

Word & PowerPoint

1.

Highlight the text for which you want to designate a language.
Click “Tools” in the menu bar. A drop-down menu will open.

2.
3. Select “Language...”. A pop-up menu will open with a list of languages.
4.
5

Choose the document’s language and then select OK.
If working with multiple languages, repeat steps 1-4 for each language.

Outlook

1.
2.

PDF

HTML

Highlight the text for which you want to designate a language.
In the options tab, click on the Language button. A pop-up menu will open with a list
of languages.

3. Choose the document's language and then select OK.
4.

If working with multiple languages, repeat steps 1-3 for each language.

In the menu bar, choose File and then “Properties...". A pop-up menu will open.
Open the Advanced tab. There will be a field for language in the Reading Options
area. Choose the document’s language from the drop-down menu and then click
OK.

To designate the default language for the entire document, add a language attribute
inside the <html> tag.
o Not sure which language code to use? See this list of ISO Language Codes.

n "

<html lang="en">

To designate the language for a section of the document not in the default
language, add a language attribute to that section's tag.
o Not sure which language code to use? See this list of ISO Language Codes.
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Provide Sufficient Color Contrast

All Document Types

Use WebAIM Contrast Checker to test if your color combination passes Web Content

Accessibility Guidelines (WCAG) standards. While Level AA passing is acceptable, your goal

should always be to pass Level AAA standards.

1. Enter the text color into the Foreground Color field, either by clicking on the bar of
color and selecting the text color from the pop-up menu (works well if you are using
a generic color) or by entering the hex color code (works well for specific colors).
e If you do not know your color’s hex color code, follow these steps

1 In your word processing program (Word, Outlook, Adobe Acrobat,
etc.), make sure your cursor is in an area of text with the color.

2 Click the Font Color button and then choose “More colors...”

3 Navigate to the RGB sliders section and double check that the right
color is entered. If it is the correct color, the Hex Color # on the page
corresponds to your color.

e Hex color codes for frequently used colors:

Husky purple #33006F

Husky gold #E8D3A2

Metallic gold #917B4C

Black #000000

o0 White #FFFFFF

2. Enter the Background Color using the same process from step 1.

3. The Contrast Checker will automatically update to show whether the
text-to-background contrast passes the Level AA and Level AAA standards.

4. |If the text-to-background contrast does not pass, try picking a different color
combination or adjusting the lightness sliders in the Contrast Checker. If using the
sliders, you can use the hex color codes to enter those colors into the document
once you find a combination with sufficient contrast.

O O oo
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